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1. Introduction 

 

The objective of this application is to evaluate the strength characteristics of an upper-limb 
prosthesis (Fig. 1) by simulating a distal tensile test with the finite element analysis (FEA) 
module SolidWorks Simulation [WWW2022b] included in the SolidWorks CAD package 
[WWW2022a]. The principle of the test is shown in Figure 2. As one may notice, the prosthesis 
is subjected to a distal traction load after being firmly attached to a rigid support that fits inner 
surfaces of the upper arm. The traction load gradually increases from 0 (zero) to 750 N. 
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Figure 1: 3D model of the upper-limb prosthesis 
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Figure 2: Principle of the distal tensile test simulated for evaluating the strength 
characteristics of the upper-limb prosthesis (red surfaces – regions where the upper arm is 

firmly attached to a rigid support; blue surface – support of the traction load) 



 

 

The following hypotheses are adopted when preparing the finite element model of the 
tensile test: 

• The prosthesis components are made of PETG exhibiting an isotropic linear elastic 
behavior. Table 1 lists the physical and mechanical properties of this material that are 
relevant for the finite element model of the tensile test. 

• The prosthesis components are bonded together along their contact surfaces. 
 

Table 1: Physical and mechanical properties of PETG [Kan2020] 
 

Mass density 
ρ [kg/m3] 

Elastic modulus 
E [MPa] 

Poisson’s ratio 
ν [-] 

Yield strength 
Y [MPa] 

1270 1660 0.419 30.3 
 

The input files needed for preparing the finite element model of the tensile test are stored 
in the folder Upper-limb prosthesis FEA: 

Upper arm.SLDPRT – 3D model of the upper arm (Fig. 1) 5 
Forearm.SLDPRT – 3D model of the forearm (Fig. 1) 
Wrist.SLDPRT – 3D model of the wrist (Fig. 1) 
Effector.SLDPRT – 3D model of the effector (Fig. 1) 
Pin.SLDPRT – 3D model of the pin (Fig. 1) 
Upper-limb prosthesis.SLDASM – 3D model of the prosthesis (Fig. 1) 
EMERALD CAE Materials.sldmat – custom library storing the physical and mechanical 

properties of PETG listed in Table 1. 
The selection set Selection-Set1(10) Upper arm - Fixed (defined in the file Upper-limb 
prosthesis.SLDASM) collects the surfaces where the upper arm is firmly attached to the rigid 
support. 

The displacement (deflection), force and stress quantities manipulated by the FEA model 
are expressed using the following measurement units: displacement (deflection) – millimeter 
[mm]; force – Newton [N]; stress – megapascal [MPa] (1 MPa = 1 N/mm2). 

The next sections of this documentation describe the preparation of the FEA model and 
the interpretation of the numerical results. 



 

 

 

2. Preparation of the finite element model 
 

The FEA model of the tensile test (Fig. 2) is developed by performing the following steps: 

a) Open the Upper-limb prosthesis.SLDASM model in SolidWorks (Fig. 3). 
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Figure 3: Upper-limb prosthesis.SLDASM model open in SolidWorks 

 

 
b) Activate the SolidWorks Simulation module by accessing the “SOLIDWORKS Add-Ins” tab 

of the “Command Manager” toolbar (Fig. 4) and pressing the “SOLIDWORKS Simulation” 
button (Fig. 5). Consequently, the “Simulation” tab is included in the “Command Manager” 
toolbar (Fig. 6). 

c) Change some working parameters of the SolidWorks Simulation module by accessing the 
“Simulation” menu and selecting the “Options…” command (Fig. 7). Consequently, the 
“System Options – General” window is displayed. In the “Default Options” panel, select 
the SI (MKS) unit system, then change the following measurement units: 
length/displacement [mm] and pressure/stress [N/mm2] (Fig. 8). 



 

 

 

 
 

Figure 4: “SOLIDWORKS Add-Ins” tab in the “Command Manager” toolbar 
 

Figure 5: “SOLIDWORKS Simulation” button in the “SOLIDWORKS Add-Ins” toolbar 
 

 

Figure 6: “Simulation” tab included in the “Command Manager” toolbar after the activation 
of the SolidWorks Simulation module 7 

Figure 7: “Options…” command in the “Simulation” menu 



 

 

 

 
 

Figure 8: Changes to be made in the “Default Options” panel of the “System Options – 8 
General” window 

d) Add the folder Upper-limb prosthesis FEA to the list of places where SolidWorks looks for 
material libraries by accessing the “Tools” menu and selecting the “Options…” command 
(Fig. 9). Consequently, the “System Options – General” window is displayed. In the “System 
Options” panel, select the “File Locations” entry (Fig. 10). Unroll the “Show folders for:” 
drop-down list and select the “Material Databases” item (Fig. 11). After pressing the 
“Add…” button (Fig. 12), the “Select Folder” window is displayed on the screen (Fig. 13). 
Look for the folder Upper-limb prosthesis FEA, select it and press the “Select Folder” button 
placed at the bottom of the “Select Folder” window (Fig. 13). Press the “OK” button placed 
at the bottom of the “System Options – General” window (Fig. 14). 

e) Enter the “Simulation” toolbar and press the “New Study” button (Fig. 15) to create a FEA 
model having the following characteristics (Fig. 16): 
• name of the FEA model: “Static 1” 
• type of the FEA model: “Static”. 

Press the “OK” button placed at the upper-left corner of the “Study” window (Fig. 16). 
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Figure 9: “Options…” command in the “Tools” menu 
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Figure 10: “File Locations” entry in the “System Options” panel of the “System Options – 
General” window 
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Figure 11: “Material Databases” item in the “Show folders for:” list 



 

 

 

 

Figure 12: “Add…” button to be pressed for modifying the list of places where SolidWorks 12 
looks for material libraries 

 

Figure 13: Selecting the folder Upper-limb prosthesis FEA for being added to the list of places 
where SolidWorks looks for material libraries 
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Figure 14: Folder Upper-limb prosthesis FEA included in the list of places where SolidWorks 
looks for material libraries 

 

Figure 15: Creation of a new FEA model 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

14 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16: Defining the name and type of the new FEA model 



 

 

f) Press the right button of the mouse on the “Parts” entry of the FEA tree and select the 
“Apply Material to All…” command from the drop-down menu to define the material 
properties of the prosthesis components (Fig. 17). Consequently, the “Material” window 
is displayed (Fig. 18). In that window, minimize the “SOLIDWORKS Materials” library, unroll 
the “EMERALD CAE Materials” library, unroll the “Plastics” category, select the “PETG” 
material, then press the buttons “Apply” and “Close” placed at the bottom of the 
“Material” window. 

Note: The yield strength Y = 30.3 MPa (see the PETG material data listed in Table 1 and 
Figure 18) defines the upper limit of the von Mises equivalent stress that can be supported 
by the prosthesis components. 

g) Do not change the option “Global Interaction (-Bonded-Meshed Independently-)” 
activated by default under the “Connections” and “Component Interactions” entries of the 
FEA tree (Fig. 19). This option is consistent with the hypotheses formulated in §1. 
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Figure 17: Defining the material properties of the prosthesis components 



 

 

 

 
 

Figure 18: Associating the PETG material to the prosthesis components 
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Figure 19: Contact option activated by default in the FEA tree (to be left unchanged) 



 

 

h) Press the right button of the mouse on the “Fixtures” entry of the FEA tree and select the 
“Fixed Geometry…” command in the drop-down menu (Fig. 20). Perform the following 
actions in the “Fixture” dialogue box to define a full locking boundary condition on some 
inner surfaces of the upper arm (Fig. 21): 
• Press the left button of the mouse in the “Faces, Edges, Vertices for Fixture” selection 

box of the “Fixture” dialogue box 
• Unroll the assembly tree placed at the upper-left corner of the SolidWorks graphics 

area 
• Unroll the “Selection Sets” entry of the assembly tree 
• Select “Selection-Set1(10) Upper arm - Fixed” in the assembly tree 
• Press the “OK” button of the “Fixture” dialogue box. 
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Figure 20: Defining full locking boundary conditions 
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Figure 21: Full locking boundary conditions defined on some inner surfaces of the upper arm 
 

 
i) Press the right button of the mouse on the “External Loads” entry of the FEA tree and 

select the “Force…” command in the drop-down menu (Fig. 22). Perform the following 
actions in the “Force/Torque” dialogue box to define the distal traction load that acts on 
the prosthesis (Fig. 23): 
• Activate the “Selected direction” radio button 
• Press the left button of the mouse in the “Faces, Edges, Vertices, Reference Points for 

Force” selection box 
• Select the blue surface of the prosthesis effector in the SolidWorks graphics area 
• Press the left button of the mouse in the “Face, Edge, Plane for Direction” selection 

box 
• Unroll the assembly tree placed at the upper-left corner of the SolidWorks graphics 

area 



 

 

• Select “Front Plane” in the assembly tree 
• Press the “Normal to Plane” button in the “Force” region of the “Force/Torque” 

dialogue box 
• Do not change the force value specified by default (1 N) in the “Normal to Plane” input 

box 
• Press the “OK” button of the “Force/Torque” dialogue box. 

Note: The actual values of the traction force are defined in step (k) as load cases. 
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Figure 22: Defining a force-type boundary condition 
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Figure 23: Defining the distal traction load that acts on the prosthesis 
 

 
j) Press the right button of the mouse on the “Mesh” entry of the FEA tree and select the 

“Create Mesh…” command in the drop-down menu (Fig. 24). Perform the following actions 
in the “Mesh” dialogue box to generate the finite element mesh (Fig. 25): 
• Move the “Mesh Factor” cursor to the “Fine” position 
• Press the “OK” button of the “Mesh” dialogue box. 

Note: The finite element mesh generated by SolidWorks Simulation is shown in Figure 26. 
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Figure 24: Initiating the generation of the finite element mesh 



 

 

 

 
 

Figure 25: Defining the control parameters of the finite element mesh 
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Figure 26: Finite element mesh generated by SolidWorks Simulation 



 

 

k) Press the right button of the mouse on the root of the FEA tree and select the “Load Case 
Manager” command in the drop-down menu (Fig. 27). Consequently, the “Load Case View” 
tab is displayed at the bottom of the SolidWorks graphics area (Fig. 28). Perform the 
following actions in that tab to define the actual values of the traction load that acts on 
the prosthesis: 
• Press the left button of the mouse in the box labeled “+ Click here to add a primary 

load case” to define the first load case (Fig. 29) 
• Replace the “Suppress” status of the “Force-1” cell with 150 (Newton) i.e., the actual 

value of the pressure corresponding to “Load Case 1” (Fig. 29) 
• Press the left button of the mouse in the box labeled “+ Click here to add a primary 

load case” to define the second load case (Fig. 29) 
• Replace the “Suppress” status of the “Force-1” cell with 300 (Newton) i.e., the actual 

value of the pressure corresponding to “Load Case 2” (Fig. 30) 
• Proceed in the same manner to define “Load Case 3”: 450 N, “Load Case 4”: 600 N, and 

“Load Case 5”: 750 N (Fig. 31) 
• Press the left button of the mouse in the box labeled “+ Click here to add a sensor to 

track a result” (Fig. 31) 23 
• Select the “+ Add Sensor…” command in the drop-down list displayed at the bottom of 

the “Load Case View” tab (Fig. 32) 
• Perform the following actions in the “Sensor” dialogue box to define a sensor for 

tracking the maximum value of the von Mises equivalent stress at the level of the entire 
FEA model (Fig. 33): 

o Select the option “Stress” from the “Results” drop-down list 
o Select the option “VON: von Mises Stress” from the “Component” drop-down 

list 
o Select the option “N/mm^2 (MPa)” from the “Units” drop-down list 
o Press the “OK” button placed at the upper-left corner of the “Sensor” dialogue 

• Come back to the “Load Case View” tab and press again the left button of the mouse 
in the box labeled “+ Click here to add a sensor to track a result” (Fig. 34) 

• Select the “+ Add Sensor…” command in the drop-down list displayed at the bottom 
of the “Load Case View” tab (Fig. 34) 

• Perform the following actions in the “Sensor” dialogue box to define a new sensor for 
tracking the maximum deflection at the level of the entire FEA model (Fig. 35): 



 

 

o Select the option “Displacement” from the “Results” drop-down list 
o Select the option “URES: Resultant Displacement” from  the “Component” 

drop-down list 
o Select the option “mm” from the “Units” drop-down list 
o Press the “OK” button placed at the upper-left corner of the “Sensor” dialogue. 

At this stage, the finite element model of the tensile test is prepared and transferred to 
the SolidWorks Simulation solver by pressing the “Run” button of the “Load Case View” tab 
(Fig. 36). The numerical results generated by the solver are interpreted in the next section. 
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Figure 27: Accessing the Load Case Manager 
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Figure 28: “Load Case View” tab displayed at the bottom of the SolidWorks graphics area 



 

 

 
 
 
 
 

 
 

Figure 29: Defining the first load case (traction force of 150 N) 
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Figure 30: Defining the second load case (traction force of 300 N) 
 
 
 

Figure 31: Actual values of the traction force defined as load cases 



 

 

 

 
 

Figure 32: Initiating the definition of a sensor for tracking the numerical results 
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Figure 33: Definition of a sensor for tracking the maximum value of the von Mises equivalent 
stress at the level of the entire FEA model 



 

 

 

 
 

Figure 34: Initiating the definition of a new sensor for tracking the numerical results 
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Figure 35: Definition of a sensor for tracking the maximum deflection at the level of the 
entire FEA model 



 

 

 

 
 

Figure 36: Transferring the finite element model to the SolidWorks Simulation solver 
 
 

3. Interpretation of the numerical results 
 
 

As soon as the solver finishes its job, the control is transferred to the “Results View” tab which 29 

is displayed at the bottom of the graphics area. At the same time, a color map showing the 
distribution of the von Mises equivalent stress at the level of the entire assembly appears on 
the screen (Fig. 37). This distribution corresponds to the first load case. The user can explore 
the other load cases by selecting them with the left button of the mouse in the first column of 
the “Primary Load Cases” table placed at the bottom of the “Results View” tab (see Figure 37, 
as well as the examples shown in Figures 38 and 39). 

Perform the following actions to display the distribution of the deflection at the level of 
the entire assembly: 

a) Press the right button of the mouse on the item “Displacement1 (-Res disp-)” under the 
“Load Case Results” entry of the FEA tree, and select the “Show” command in the drop- 
down menu to examine the distribution of the deflection (Fig. 40) 

b) Examine the distribution of the deflection associated to different load cases by selecting 
them with the left button of the mouse in the first column of the “Primary Load Cases” 
table placed at the bottom of the “Results View” tab (see the examples shown in Figures 
41 and 42). 
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Figure 37: Analyzing the numerical results associated to different load cases with the help of 
the “Results View” tab and the “Load Case Results” entry of the FEA tree 
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Figure 38: Color map showing the distribution of the von Mises equivalent stress at the level 
of the entire assembly (fourth load case: traction force of 600 N) 
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Figure 39: Color map showing the distribution of the von Mises equivalent stress at the level 
of the entire assembly (fifth load case: traction force of 750 N) 



 

 

 

 
 

Figure 40: Selecting the distribution of the deflection to be examined 
 
 

The maximum value of the von Mises equivalent stress σeq,max, the maximum deflection 
dmax, and the traction force F corresponding to different load cases are listed in the second, 
third and fourth column of the “Primary Load Cases” table placed at the bottom of the “Results 
View” tab (Fig. 43). Table 2 (see below) presents this data in a more readable format. 33 

The plots in Figures 44 and 45 show the dependencies σeq,max vs F and dmax vs F, 
respectively. Both diagrams allow noticing that the mechanical response of the prosthesis is 
linear. In fact, the dependencies σeq,max vs F and dmax vs F are well approximated by the 
regressions 

σeq,max = 4.337 · 10-2 · F, (1) 

and 

dmax = 1.794 · 10-2 · F, (2) 

respectively (see the black lines in Figures 44 and 45). 

It can be easily seen in Table 2 and Figure 44 that σeq,max equals the yield strength of the 
PETG material Y = 30.3 MPa (as defined in the EMERALD CAE Materials.sldmat library – see 
Table 1 and Figure 18) for a traction force 600 N < Fcr < 750 N. This critical load results from Eq 
(1) as soon as the replacement σeq,max = Y = 30.3 MPa is made: 

Fcr = Y · 100 / 4.337 = 30.3 · 100 / 4.337 = 698.64 N. (3) 
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Figure 41: Color map showing the distribution of the deflection at the level of the entire 
assembly (fourth load case: traction force of 600 N) 
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Figure 42: Color map showing the distribution of the deflection at the level of the entire 
assembly (fifth load case: traction force of 750 N) 



 

 

 

 
 

Figure 43: Maximum value of the von Mises equivalent stress, maximum deflection, and 
traction force corresponding to different load cases listed in the “Primary Load Cases” table 

 

Table 2: Traction force, maximum value of the von Mises equivalent stress, and maximum 
deflection corresponding to different load cases (see also Figure 43) 
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Figure 44: Dependence σeq,max vs F: red dots – numerical results taken from Table 2; black 

line – linear regression defined by Eq (1) 

Load case 
Traction force 

F [N] 
Maximum value of the von Mises 

equivalent stress σeq,max [MPa] 
Maximum deflection 

dmax [mm] 
1 150 6.51 2.691 
2 300 13.01 5.382 
3 450 19.52 8.073 
4 600 26.03 10.764 
5 750 32.53 13.455 

 



 

 

 

 
 

Figure 45: Dependence dmax vs F: red dots – numerical results taken from Table 2; black line – 
linear regression defined by Eq (2) 

 
 
 

4. Suggestions for individual work 
37 

 
a) Evaluate the strength characteristics of the upper-limb prosthesis by simulating the distal 

tensile test under the hypothesis that all the components are made of PLA exhibiting an 
isotropic linear elastic behavior. Table 3 lists the physical and mechanical properties of this 
material that are relevant for the finite element model. 

 
Table 3: Physical and mechanical properties of PLA [Far2016] 

 

Mass density 
ρ [kg/m3] 

Elastic modulus 
E [MPa] 

Poisson’s ratio 
ν [-] 

Yield strength 
Y [MPa] 

1252 3500 0.36 59 
Note: The properties listed in Table 3 are stored in the custom library EMERALD CAE 
Materials.sldmat. 

b) Develop another design of the upper-limb prosthesis and evaluate its strength 
characteristics by simulating the distal tensile test. 
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